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Preface

Audience
This document is intended for Oracle Beehive Release 2 (2.0) administrators and any 
other person charged with overseeing one or more aspects of an Oracle Beehive 
deployment.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Related Documents
For more information, see the following documents in the Oracle Beehive Release 2 
(2.0) documentation library:

Administration Guides
■ Oracle® Beehive Administrator's Guide

■ Oracle® Beehive Administrator's Reference Guide

■ Oracle® Beehive Integration Guide

Application Development
■ Oracle® Beehive Application Developer's Guide

■ Oracle® Beehive Business Views

■ Oracle® Beehive Java Content Repository Java API Reference

■ Oracle® Beehive RESTful Web Services API Reference
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■ Oracle® Beehive SOAP Web Services API Reference

Installation Guides
■ Oracle® Beehive Installation Guide for Linux

■ Oracle® Beehive Installation Guide for Microsoft Windows

■ Oracle® Beehive Installation Guide for Oracle Solaris on SPARC (64-Bit)

■ Oracle® Beehive Installation Help (Integrated UA)

Online Helps
■ Oracle® Beehive Central

■ Oracle® Beehive Webmail

■ Oracle® Beehive Standards-based Clients

■ Oracle® Beehive Team Collaboration

■ Oracle® Beehive Conferencing

■ Oracle® Beehive Extensions for Outlook Supplemental Help & Release Notes

■ Oracle® Beehive Extensions for Explorer Supplemental Help & Release Notes

■ Oracle® Beehive Extensions for Explorer (OBEE) (Integrated UA)

■ Oracle® Beehive Extensions for Outlook (OBEO) (Integrated UA)

Mobile Devices
■ Oracle® Beehive Using Windows Mobile Device

■ Oracle® Beehive Using iPhone or iPad

■ Oracle® Beehive Using BlackBerry

■ Oracle® Beehive Registering and Configuring Mobile Devices

Planning Guides
■ Oracle® Beehive Concepts

■ Oracle® Beehive Deployment Guide

■ Oracle® Beehive Licensing Information

Release Notes
■ Oracle® Beehive Release Notes

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1 Getting Started

What is Oracle Beekeeper?
Oracle Beekeeper is a Web-based application that allows you to manage your Oracle 
Beehive deployment using an intuitive, user-friendly interface. Using Oracle 
Beekeeper, you can provision users, view your deployment topology, set role 
definitions, manage Oracle Beehive services, and administer many other aspects of 
your Oracle Beehive deployment.

Oracle Beekeeper and Security
For security reasons, Oracle strongly recommends using SSL encryption in your Oracle 
Beekeeper installation.
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2 Managing Your System

This module describes how to manage your Oracle Beehive system using Oracle 
Beekeeper, and includes the following sections:

■ Topology

■ Managing Virus Scanning Configuration

■ Managing Oracle Database Configuration

■ Comparing Topology Configuration Versions

■ Configuration Control

■ Metrics Dashboard

■ Log Viewer

■ Client Applications

■ Coexistence

■ Records

■ External Directories

Topology
The Topology module allows you to stop and start individual Oracle Beehive 
components, while providing you with a broad view of your deployment topology. 
You can review your deployment By Topology (with each set of component instances 
separated by Application tier, or By Service (with all instances of a given service listed 
together).

From the Topology module, you can also do the following:

■ View the Virtual Server for a site

■ Create and modify the Virus Scan Engine Cluster configuration for a site

■ Manage the Database settings for your Oracle Beehive Database

■ Compare topology configuration versions

To access these options, from the Topology pane, select the site you want to manage, 
and from the View menu, click View Configuration. Or, in the By Service tab, select 
the site you want to manage, and from the View menu, click View Configuration.
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Managing Virus Scanning Configuration
To access virus scan engine configuration options, from the Topology pane, select the 
the site you want to manage, and from the View menu, click View Configuration. Or, 
in the By Service tab, select the site you want to manage, and from the View menu, 
click View Configuration. 

Then, click the Virus Scan Engine Cluster tab.

Creating a Virus Scan Engine Cluster Configuration

1. From the Topology pane, select the site you want to manage, and from the View 
menu, click View Configuration. Or, in the By Service tab, select the site you want 
to manage, and from the View menu, click View Configuration. 

Then, click the Virus Scan Engine Cluster tab.

2. Click Edit. From the Proposed Configuration Version window, select the Virus 
Scan Engine Cluster tab, and click the Create Virus Scan Engine Cluster button.

3. Optionally, enter an Alias for your cluster. Select a Virus Scan Policy from the 
drop down list.

4. To access additional advanced parameters, click the Advanced link.

5. in the ScanEngines section, click the plus icon to add one or more scan engines. 
For each scan engine, enter the Scan Engine Host Name and Scan Engine Client 
Comm Port, and optionally, enter an Alias.

6. Click Apply to apply your configuration changes without closing the window, or 
click Save & Close to apply your changes and close the window.

Managing Oracle Database Configuration
The settings used by Oracle Beehive to access the Oracle Database are first set during 
installation of Oracle Beehive.

To access Oracle Database configuration options, from the Topology pane, select the 
the site you want to manage, and from the View menu, click View Configuration. Or, 
in the By Service tab, select the site you want to manage, and from the View menu, 
click View Configuration. 

Then, click the Database tab.

Expand the subsections of database configuration settings, and then click Advanced to 
see advanced settings.

To edit database connection settings, click the Edit button. In the Proposed 
Configuration window, click the Database tab.

Notes:

■ In this section, you create a configuration in Oracle Beehive that 
points to a virus scan engine cluster. The actual virus scan engine 
cluster is a system external to Oracle Beehive.

■ Virus scanning of e-mail is only enabled after you also configure 
virus scanning rules for the Email Service.
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When you have finished making configuration changes, click Apply to apply your 
changes to the proposed configuration, or click Save & Close to apply your changes 
and close the window.

To validate and apply your configuration changes, use the Configuration Control 
module.

Comparing Topology Configuration Versions
From the Virtual Server, Virus Scan Engine Cluster, or Database tabs, or from any 
component in the Topology viewer, you can compare current and prior configurations 
and proposed configurations, to see which properties may have been changed. To 
compare configurations:

1. Click on any component in the Topology viewer. Or, select the site you want to 
manage and from the View menu, click View Configuration. Or, in the By Service 
tab, select the site you want to manage, and from the View menu, click View 
Configuration.

2. On the Configuration tab, click Compare. The Compare Configuration Versions 
window opens.

3. Using the drop down boxes, select a Baseline Version and an Other Version to 
compare to it. Click Compare. In the lower pane, any differences between the two 
configuration versions are shown.

4. When you are done reviewing the changes, close the Compare Configuration 
Versions window.

Configuration Control
The Configuration Control module allows you to verify, activate, and clear changes 
made to components such as sites, servers, services, and Oracle Application Server 
Containers for J2EE (OC4J) instances.

Active Configuration
The currently running Oracle Beehive configuration is known as the active 
configuration.

To view the active configuration version:
In the System panel, select Configuration. The Configuration pane appears in the 
right-side of the screen. The version number is displayed in the Active Configuration 
section.

Proposed Configuration
A saved Oracle Beehive configuration that has not yet been activated is known as the 
proposed configuration. You can view the proposed configuration version number in the 
Proposed Configuration section of the Configuration pane.

Caution: Most database configuration parameters are Advanced. If 
you incorrectly configure database attributes, you could cause Oracle 
Beehive to lose connectivity to the database, or otherwise impact the 
performance of Oracle Beehive.
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Validating a Proposed Configuration
Before activating a proposed configuration, you must validate it to ensure that there are 
no errors.

To validate a proposed configuration:
1. In the System panel, select Configuration.

2. In the Proposed Configuration section, click Validate.

3. If your proposed configuration is validated, click OK. If the proposed 
configuration is not successfully validated, any management or configuration 
errors are displayed in a message box. You cannot activate a proposed 
configuration until you correct your validation errors.

Activating a Proposed Configuration

To activate a proposed configuration:
1. In the System panel, select Configuration.

2. In the Proposed Configuration section, click Activate. The system will confirm 
that the proposed configuration was successfully activated.

3. Click OK.

Deleting a Proposed Configuration
After you have deleted all proposed configurations, the proposed configuration 
becomes identical to the currently running configuration.

To delete a proposed configuration:
1. In the System panel, select Configuration.

2. In the Proposed Configuration section, click Clear. The system will confirm that 
all proposed configurations have been deleted.

3. Click OK.

Metrics Dashboard
Using the Metrics Dashboard module, you can monitor Oracle Beehive availability, 
performance, and usage, for one or more services. Metrics shown on the dashboard are 
static; to update the values shown, click Refresh.

Adding Metrics

To add metrics from the Metrics Dashboard:
1. From the Metrics Dashboard pane, click New.

2. From the Service pull-down menu, select an Oracle Beehive service to be 
monitored.

3. Select one or more metrics using the check boxes in the Metric list. Alternatively, 
select the All check box to add every metric for the Oracle Beehive service you 
have chosen.

4. In the Scope section, select a scope for the metrics. Alternatively, select the All 
check box to add every scope for the metrics you have chosen.
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5. Click OK.

To add metrics from any Service panel:
1. From any Service or Service Instance view, click the Metrics tab.

2. Select one or more metrics, and click Add. The metrics are added to the Metrics 
Dashboard.

Filtering Metrics
Using the options in the View menu, you can filter the main metrics view based on 
scope and metric type. You can also display metrics in a table view or box view.

Removing Metrics
Once you have added a metrics group to the dashboard, from the Table view, you can 
remove the whole group. From the Action pull-down menu, select Remove All 
Metrics to clear the metrics dashboard, or, select Remove Group and select a metrics 
group to remove that group.

You can also remove individual metrics. Select one or more metrics, and from the 
Action pull-down menu, select Remove Selected.

Log Viewer
The Log Viewer module allows you to search Oracle Beehive logs to monitor 
performance and gauge the overall stability of your Oracle Beehive installation.

Searching for Log Entries

To search for log entries:
1. From the Search drop down list, pick Repository to search the log repository, or 

pick FileSystem to search log files stored in the Oracle Beehive Application tier 
log folder

2. If you are searching the FileSystem, pick values from the Hostname and Beehive 
Home drop down lists to determine which Oracle Beehive homes will be included 
in the search. 

Pick one or more components from the Component drop down list to include logs 
from those components in the search.

3. Enter the search string in the Search field. You can perform a search using one or 
more of the following attributes (with the format attribute:value). Click the 
Advanced icon to create a complex query:

■ Date Range

■ Severity

■ Message Text

■ Message Details

■ Beehive Error Code

■ Message Group

■ Hostname
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■ Component ID

■ Beehive Component ID

■ Beehive Component Name

■ Logon Record ID

■ Principal ID

■ Organization ID

■ Module ID

■ Instance ID

■ Thread ID

■ Process ID

■ User ID

■ Error Instance ID

■ Execution Context ID

For more information, see Performing Simple Searches.

4. With the cursor in the search box, use the Enter key to run the search. Or, from the 
Advanced Search menu, click Search.

5. Click the Clear icon to reset the Log Viewer pane and repeat the search with a new 
string.

Alternatively, perform an advanced search by following the steps described in 
Performing Advanced Searches.

Viewing Your Search Results
Using the options in the View menu, you can control which attributes are displayed as 
columns for your search results.

Clicking a column header will sort your search results by that attribute.

To view the details for a given log entry, select the entry in the Log Viewer window 
and click Action, and then Open, or double-click the log entry.

Exporting Log Entries
You can export individual log entries in an XML format.

To export a log entry, select it in the Log Viewer window and click Export. 
Alternatively, select multiple log entries while holding down Ctrl and click Export.

Client Applications
The Client Applications module allows you to manage applications in the application 
repository.

Clicking Client Applications in the System pane brings up the application tree view, 
which lists the following details for each application: 

■ Name

■ Vendor
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■ Application version

■ Supported device type

■ Supported operating system

■ Supported processor

■ Supported languages

Selecting an application brings up the detail area for the application.

Clicking + next to an application displays all versions for the selected application. 
Selecting an application version brings up a read-only detail area for the version.

Filtering the Application List
Using the options in the View menu, you can filter items in the Client Applications 
window by type, device class, processor, or operating system. You can also choose to 
view all applications or only installable applications in the repository.

Displaying Patch Set Files
Clicking + next to an application version displays all installable applications for the 
version. By default, the base application is always listed as patch 0 and cannot be 
provisioned. Dynamic installable applications are shown under the base application, 
while static installable applications are nested in the patch set they represent.

Static and Dynamic Installable Applications
A static installable application points to a specific patch set. A dynamic installable 
application points to the latest patch set for a given application version.

Deleting Applications, Versions, or Patch Sets
To delete an application, version, or patch set from the repository, select it in the Client 
Applications window, click Delete, and click OK to confirm the deletion. Deleting an 
item deletes all nested application versions and patch sets. If you want to delete an 
item that contains an installable application, you must manually delete the installable 
application before deleting the parent item.

Uploading Applications to the Repository

To upload an application to the repository:
1. From the Actions menu, select Upload.

2. Click Browse.

3. Select an appropriate package in .zip format and click Open.

4. Click Upload.

5. Optionally, repeat steps 2 through 4 to upload additional applications.

6. Click Close to return to the Client Applications window.

See Also: For more information about uploading applications, see 
"Uploading and Provisioning a New Application" in Chapter 7, 
"Managing Oracle Beehive Mobility Services" of the Oracle Beehive 
Administrator's Guide.
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Creating Static Installable Applications
You can create a static installable application from a selected patch-set, or from an 
existing static installable application. For more information, see Static and Dynamic 
Installable Applications.

To create a static installable application:
1. In the Client Applications window, select the patch-set for the desired 

application. Alternatively, select an existing installable application.

2. Click New.

3. Enter a name for the installable application in the Installable Name field.

4. Click Yes.

Creating Dynamic Installable Applications
You can create a dynamic installable application when an application version is 
selected and no dynamic installable application exists for the selected version. For 
more information, see Static and Dynamic Installable Applications.

To create a dynamic installable application:
1. In the Client Applications window, select an application version for which no 

dynamic installable application currently exists.

2. Click New.

3. Enter a name for the installable application in the Installable Name field.

4. Click Yes.

Provisioning Installable Applications
You can provision installable applications for organizations within your enterprise or 
your entire enterprise.

To provision an installable application:
1. In the Client Applications window, select the installable application.

2. Click the Provisioning tab.

3. Click Add.

4. To provision the installable application for your entire enterprise, select your 
enterprise from the list and click >. Alternatively, select your enterprise, click the 
View Organizations icon, select an organization from the list, and click >.

5. Click Add.

6. Click Apply to save your changes.

Coexistence
To implement the Oracle Beehive coexistence solution, you must add and configure 
coexistence connectors based on the requirements of your deployment. Typically, there 
is one connector between each Oracle Beehive server and Microsoft Exchange Server 
routing group.
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Records
The Records module allows you to set or modify the settings for Oracle Universal 
Records Management (Oracle URM), to enable Records Management in Oracle 
Beehive.

From the Records pane, you can view the URM Adapter’s status in the Adapter Status 
box. Click Refresh to refresh the Adapter Status.

From the URM Adapter Settings box, you can view or modify the current connection 
settings for the URM Adapter. Click the Create button to add a new URM Adapter.

You can modify parameters for the URM Agent in the URM Agent Settings box. Enter 
new values, and then click Apply to apply your changes.

External Directories
You can configure the User Directory Service (UDS) for integration with supported 
external user directory servers. You can also configure the Authentication Service to 
leverage the same external user directories for authentication attributes such as user 
names and passwords. 

For each external user directory, you must create a directory profile. You can have 
multiple profiles, if your deployment includes multiple LDAP-based server hosts, but 
only one profile can be set to Default and Active. Additional profiles can be set to 
Active, but they will not be in effect. Only one profile can be flagged as Default.

Creating a Directory Profile
To synchronize with a remote LDAP-based user directory, you must create a directory 
profile.

1. From the System menu, click External Directories. From the External Directories 
pane, click Edit.

2. From the External Directories Edit window, click New.

3. In the New Directory Profile window, enter information about your external 
directory:

■ Give the profile a Profile Name

■ Select the Directory Type

Note: Oracle URM is a separate product not included with Oracle 
Beehive. For more information about using Records Management with 
Oracle Beehive, see "Managing Records Management" in Chapter 6, 
"Managing Oracle Beehive Workspaces" of the Oracle Beehive 
Administrator's Guide.

Caution: If you are using an external user directory, you cannot use 
Oracle Beehive to create users directly. When you set up an external 
user directory, any existing users you have created directly in Oracle 
Beehive will be deleted.

See Also: For more information, consult the "Integrating and 
Synchronizing LDAP with Oracle Beehive" module of the Oracle 
Beehive Installation Guide.
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■ Optionally, enter a Primary Authentication Attribute

■ Enter a User Search Base

■ Enter a Server Host, Server Port, User Name, and User Password, which 
Oracle Beehive will use to access your remote directory. Enter the password 
again in the Confirm Password field. Check the Use secure connection check 
box to use an encrypted protocol to connect to the indicated port.

■ Optionally, enter a Group Search Base

■ Optionally, enter a Polling Interval (in seconds). 

■ Check the Default box if this directory profile will be the default directory 
profile for your enterprise.

■ Check the Enable check box to enable this directory profile once it is created.

Click Next.

4. On the Rulesets page, configure the following:

a. In Scope and Membership Ruleset, click Configure. On the Scope Ruleset 
table, click Add to add rows. Type the name of a level of scope in the source 
directory, and then enter a Value to map it to an Oracle Beehive level of scope. 
When a scope rule is added, you may optionally add membership rules 
corresponding to the scope rule. Click Apply when you are done adding rows.

b. In User Type Ruleset, click Configure. On the User Type Ruleset table, click 
Add to add rows. Set the Source Field to a field in the source directory, set the 
Value to the value of that field that maps to an Oracle Beehive user type, and 
then use the drop down list to map it to an Oracle Beehive user type. Click 
Apply when you are done adding rows.

c. In Group Type Ruleset, click Configure. On the Group Type Ruleset table, 
click Add to add rows. Set the Source Field to a field in the source directory, 
and set the Value to a value that corresponds to a static group in Oracle 
Beehive. Click Apply when you are done adding rows.

Click Next.

5. On the Mapping page, configure the following:

a. In Enterprise User Attributes Mapping, click Configure. On the Enterprise 
User Mapping table, the default mappings for your directory type have 
already been added. Click Add to add rows. Enter a Source Attribute from 
your external directory, select a Beehive Attribute from the drop down list, 
select an attribute type, and, where applicable, select an attribute subtype or 
an OraPostal type. Click Apply when you are done adding rows.

b. In Extended Enterprise User Attributes Mapping, click Configure. On the 
Extended Enterprise User Mapping table, the default mappings for your 
directory type have already been added. Click Add to add rows. Enter a 
Source Attribute from your external directory, select a Beehive Attribute from 
the drop down list, select an attribute type, and, where applicable, select an 
attribute subtype or an OraPostal type. Click Apply when you are done 
adding rows.

Note: The Primary Authentication Attribute is mandatory when the 
Default check box is checked.
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c. In External Person Attributes Mapping, click Configure. On the External 
Person Mapping table, the default mappings for your directory type have 
already been added. Click Add to add rows. Enter a Source Attribute from 
your external directory, select a Beehive Attribute from the drop down list, 
select an attribute type, and, where applicable, select an attribute subtype or 
an OraPostal type. Click Apply when you are done adding rows.

d. In Static Group Attributes Mapping, click Configure. On the Static Group 
Mapping table, the default mappings for your directory type have already 
been added. Click Add to add rows. Enter a Source Attribute from your 
external directory, select a Beehive Attribute from the drop down list, select 
an attribute type, and, where applicable, select an attribute subtype or an 
OraPostal type. Click Apply when you are done adding rows.

6. Click Finish to create the directory profile.
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3 Managing Enterprises

This module contains describes how to manage Oracle Beehive enterprises using 
Oracle Beekeeper, and includes the following sections:

■ About Entities, Actors, and Artifacts

■ Managing Workspace Quotas

■ Searching in Oracle Beekeeper

■ Managing Users

■ Managing Groups

■ Managing Resources

■ Managing Devices

■ Managing Policies

■ Managing Roles

■ Managing Categories

■ Managing Audit

■ Managing Remote Repositories

About Entities, Actors, and Artifacts

■ An entity is an object in Oracle Beehive, such as a service, user, workspace, or 
artifact. In essence, every object in Oracle Beehive is an entity.

■ An actor is an entity, such as a user, group, or service, that acts upon other entities.

■ An artifact is a type of entity that users can view, create, modify, or delete. Artifacts 
are the results of communications and other collaborative activities, and include 
e-mail messages, meeting entries, online discussions, and documents.

Managing Workspace Quotas
You can control the maximum disk space allowed for workspaces in your enterprise.

To manage workspace quotas for your entire enterprise:
1. From the Enterprises panel, click Manage Enterprises.

2. In the Manage Enterprises window, select your enterprise.
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3. Click the Quota Settings tab.

4. Set specific quota limits for each type of quota. By default, each quota type is set to 
Unlimited.

■ Hard Quota: Set the total disk space allocated to your enterprise.

■ Sub-Organizations Hard Quota: Set the default disk space allocated to each 
sub-organization within your enterprise.

■ Team Workspace Hard Quota: Set the default disk space allocated to each 
team workspace within your enterprise.

■ Personal Workspace Hard Quota: Set the default disk space allocated to each 
personal workspace within your enterprise.

■ Team Workspace Soft Quota: Set the default quota level at which a warning 
event is created for each team workspace within your enterprise.

■ Personal Workspace Soft Quota: Set the default quota level at which a 
warning event is created for each personal workspace within your enterprise.

5. Click Apply to save your changes to the quota settings. Alternatively, click Reset 
to discard your changes.

To manage quota for a single workspace:
1. From the Enterprises panel, click the name of your enterprise.

2. In the Manage Enterprises window, select a workspace.

3. Click the Quota Settings tab.

4. Set specific limits for hard and soft quotas. By default, each quota type is set to 
Unlimited.

5. Click Apply to save your changes to the quota settings. Alternatively, click Reset 
to discard your changes.

Searching in Oracle Beekeeper
You can enter search strings in the Search field in the top-right corner of the main 
window to search for entities in Oracle Beekeeper. Alternatively, you can use the 
Advanced Search dialog box to perform searches.

Searches in Oracle Beekeeper are not case-sensitive.

Performing Simple Searches
In its most basic form, a search consists of an attribute, a keyword, and a match 
operator. An attribute is the criterion by which you intend to search for one or more 
Oracle Beehive entities. A keyword is the value for which you want to search. 
Generally, the match operator is :, which instructs Oracle Beekeeper to return all 
results for the searched attribute containing the given keyword.

You perform a simple search by entering search strings in the Search field and clicking 
the Search icon to begin your search.
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Complex Search Syntax
Oracle Beekeeper supports boolean expressions, nested predicates with parentheses, 
and the predefined attributes ANY and ALL.

■ Using the ANY attribute matches the keyword or keyphrase against any of the 
relevant search attributes.

■ Using the ALL attribute matches the keyword or keyphrase against all of the 
relevant search attributes.

If you want to specify multiple keywords for a given search, you must enclose them in 
double quotation marks. Multiple keywords in double quotation marks constitute a 
keyphrase.

Example 3–1 Complex Syntax

In the Search field, enter the following text:

(givenname:john && familyname:coetzee) || (givenname:jamaica && 
familyname:kincaid)
Your search would return the following results:

■ Any user whose given name was John and whose family name was Coetzee

■ Any user whose given name was Jamaica and whose family name was Kincaid

Performing Advanced Searches

To perform an advanced search:
1. Click the Advanced Search icon to launch the Advanced Search dialog box.

2. From the Add pull-down menu, select an attribute and click +.

3. Enter a word or part of a word in the field provided. To search for entities with an 
attribute containing the word you entered, select contains from the attribute’s 
pull-down menu. Alternatively, to search for entities with an attribute that does 
not contain the word you entered, select does not contain from the attribute’s 
pull-down menu.

4. Optionally, repeat steps 2 and 3 to search for entities using more than one 
attribute.

5. If you are searching using multiple attributes, select All to ensure that your search 
returns only entities that match all the attributes by which you are searching. 

Examples: To perform a search for all users with the word 
’developer’ in their job titles, you would enter title:developer in 
the Search field. Alternatively, to search for all members of the 
accounting department, you would enter department:accounting 
in the Search field.

Boolean Operator Oracle Beekeeper Symbol

contains :

AND &&

OR ||

NOT !
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Alternatively, select Any to ensure that your search returns entities that match any 
of the attributes by which you are searching.

6. If you want to delete any attribute search you have created, click x next to the 
attribute field.

7. Click Search. Your results are displayed in the main window behind the 
Advanced Search dialog box.

8. Click Close to return to the main window.

Managing Users
A user, also referred to as an actor, is an entity that can act on other entities. Users can 
be assigned to groups, provisioned for services, and authorized to perform tasks and 
services.

All users are part of the enterprise directory, which is managed by the User Directory 
Service (UDS).

Creating Users

To create a user:
1. In the Enterprises panel, expand the Manage Enterprises navigation tree.

2. Click Users.

3. From the menu bar, click New.

4. Click one of the tabs and enter user information:

■ General: Enter basic information such as first name and family name, time 
zone, user name, and password. You must provide a family name and a user 
name for the user.

■ Business: Enter official information such as company, organization, 
department, job title, and manager.

■ Contact Info: Enter contact information such as e-mail, phone, fax, and instant 
message address. You can also add or remove entries for each type of contact 
information using the + and x buttons. You can also select a primary entry 
from among the multiple entries for each contact information field, and 
categorize each contact information field under the Business, Personal, or 
Other category.

■ Groups: Lists the group or groups to which a user belongs. To add the user to 
a group, click Add, enter a name or part of a name in the Search field, and 
click the search icon to return a list of groups. Select a group from the list and 
click Add. Alternatively, hold down Ctrl to select multiple groups, and click 
Add. For more information, see Managing Groups.

■ Roles: Lists the role or roles assigned to the user. To assign a role to the user, 
click Add. Select a role from the list and click Add. Alternatively, hold down 
Ctrl to select multiple roles, and click Add. For more information, see 
Managing Roles.

Note: If you have configured Oracle Beehive to use an external 
directory server, you cannot create or modify users using Oracle 
Beekeeper.
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5. Click Save & Close to create the user and close the New User dialog box. 
Alternatively, click Apply to create the user without closing the dialog box.

Modifying Users

To modify information about a user:
1. In the Enterprises panel, expand the Manage Enterprises navigation tree.

2. Click Users.

3. From the displayed list of users, select the user you want to modify.

4. From the menu bar, select Actions, then Open.

5. Update any or all user information. For more information, see Creating Users.

6. Click Save & Close to save your changes and close the dialog box. Alternatively, 
click Apply to save your changes without closing the dialog box.

Disabling User Subscription Notifications
You can disable all subscription notifications for a user using Oracle Beekeeper.

To disable notifications for one or more users:
1. In the Enterprises panel, expand the Manage Enterprises navigation tree.

2. Click Users.

3. From the displayed list of users, select the user you want to modify.

4. From the menu bar, select Actions, then Disable subscriptions. After you confirm 
the action, all notifications for that user will be disabled.

Deleting Users

To delete a user:
1. In the Enterprises panel, expand the Manage Enterprises navigation tree.

2. Click Users.

3. From the displayed list of users, select the user you want to delete.

4. Click Delete.

5. Click Yes to confirm the deletion.

Searching for Users

To search for one or more users:
1. In the Users pane, enter the search string in the Search field. You can perform a 

search using one or more of the following attributes:

■ Status

■ FamilyName

Note: Users can enable and disable their own notifications 
(including after you disable them) using Oracle Beehive Central.
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■ GivenName

■ MiddleName

■ Nickname

■ Email

■ Title

■ Office

■ Department

■ Company

■ Profession

■ Manager

■ Organization

■ TimeZone

For more information, see Performing Simple Searches.

2. Click the Search icon.

3. Click x to reset the Users pane and repeat the search with a new string.

Alternatively, perform an advanced search by following the steps described in 
Performing Advanced Searches.

Managing Groups
An Oracle Beehive group is a defined collection of users or resources (or some 
combination thereof) that are related based on a line of business, a project, or another 
common association.

About Groups
Oracle Beehive provides the following group types:

■ Static groups have explicit member lists. You must manually add and remove 
members from static groups.

■ Dynamic groups have memberships defined by a query, so that users fitting 
whatever criteria is being queried are automatically made members. Dynamic 
group queries are based on any combination of user attributes, properties, or 
addresses.

Example: All users with a particular manager could belong to a 
dynamic group defined by a query against the Manager attribute of 
user accounts. Whenever a user's manager attribute is changed to that 
particular manager, that user is automatically added to the group. 
Likewise, whenever a user's manager attribute changes (the user 
switches to a different manager), that user is automatically removed 
from the group.
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Creating Static Groups

To create a static group:
1. From the New pull-down menu, select Static Group. The New Static Group 

pop-up will open in a separate window.

2. On the General tab, enter a unique name for the group. Optionally, enter a brief 
group description.

3. Optionally, click the Contact Info tab and provide contact information for the 
group.

4. Click the Members tab.

5. Click +.

6. Enter a name or part of a name in the Search field and click the search icon to 
return a list of results.

7. Select a user from the list and click Add. Alternatively, hold down Ctrl to select 
multiple users, and click Add.

8. Click Save & Close to create the static group.

Creating Dynamic Groups

To create a dynamic group:
1. From the New pull-down menu, select Dynamic Group. The New Dynamic 

Group pop-up will open in a separate window.

2. On the General tab, enter a unique name for the group. Optionally, enter a brief 
group description.

3. In the Query section, select one or more attributes to define your membership, and 
provide a value and operator for each attribute you choose. You can add members 
using any of the following attributes:

■ Family name

■ Given name

■ Middle name

■ Nickname

■ E-mail address

■ Title

■ Office

■ Department

■ Company

■ Profession

■ Manager

■ Type (Enterprise or Extended Enterprise)
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4. Click Preview to verify that your query has generated the desired membership for 
this group.

5. Optionally, click the Contact Info tab and provide contact information for the 
group.

6. Optionally, you can manually add members to a dynamic group by performing 
the following steps:

a. Click the Include tab.

b. Click Add.

c. Enter a name or part of a name in the Search field and click the search icon to 
return a list of results.

d. Select a user from the list and click Add. Alternatively, hold down Ctrl to 
select multiple users, and click Add.

7. Optionally, you can make specific roles available to group members by performing 
the following steps:

a. Click the Roles tab.

b. Click Add.

c. Leave the Search field blank and click the search icon to return a list of all 
available roles.

d. Select a role from the list and click Add. Alternatively, hold down Ctrl to select 
multiple roles, and click Add.

8. Click Save & Close to create the dynamic group.

Searching for Groups

To search for one or more groups:
1. In the Groups pane, enter the search string in the Search field. You can perform a 

search using one or more of the following attributes:

■ Name

■ Description

■ Status

For more information, see Performing Simple Searches.

2. Click the Search icon.

3. Click x to reset the Groups pane and repeat the search with a new string.

Example: You create a dynamic group intended to comprise only the 
accountants in your Montreal office. From the Add pull-down menu, 
you select Office and click +. Leaving the operator at contains, you 
enter Montreal in the edit box. From the Add pull-down menu, you 
select Profession and click +. Leaving the operator at contains, you 
enter accountant in the edit box. You click the All radio button to 
ensure that your group only contains users who meet both your 
search criteria.
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Alternatively, perform an advanced search by following the steps described in 
Performing Advanced Searches.

Changing Group Ownership

To change the owner of a group:
1. In the Groups pane, select the group you want to modify. You can edit the group 

in the lower pane, or click Open from the Action menu to open the group in a 
separate window.

2. On the General tab, next to the name of the Owner, click the Pick User icon to 
pick a new user to be the owner of the group, or, click the Pick Group icon to pick 
a new group to be the owner of this group. Use the picker to select a new owner.

3. From the lower pane, click Apply to apply your changes to the group. If you are 
modifying the group from a separate window, click Apply to apply your changes 
without closing the window, or click Save & Close to apply your changes and 
close the window.

Managing Resources
A resource is an entity that users can search for, reserve, and use for a specified period 
of time, such as a conference room or a projector.

Creating Resources

To create a resource:
1. From the New menu, click Bookable Resource or External Resource.

2. On the General tab:

■ Enter a unique Name for the resource.

■ Optionally, specify a Capacity for the resource. For example, a small 
conference room could have a capacity of 10.

■ By default, the scope for the resource is your enterprise. Click the Pick a scope 
icon to select a different scope for the resource.

■ Select a Type for the resource: Room, Equipment, or Other.

■ In the Email field, an e-mail address is suggested based on the name entered 
in the Name field. Optionally, edit the value to a different e-mail address.

■ Optionally, enter a location, description, phone number, fax number, and URL 
for the resource.

■ Optionally, for bookable resources, click the Select a category icon to pick a 
Category for the resource. Check the Require external processing check box if 
the resource requires processing outside Oracle Beehive to book.

■ Optionally, click the Select a Time Zone icon to pick a Time Zone for the 
resource

■ Optionally, provide any special information related to booking this resource in 
the Booking Info field.

3. Optionally, assign individual approvers to a bookable resource by performing the 
following steps: 
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a. Click the Approvers tab. 

b. Click Add to add an approver. Enter the full name or part of the name of an 
Oracle Beehive user in the field and click the magnifying glass to obtain a list 
of results.

c. Select a one or more users, and click the plus icon. The users now appear in 
the Approvers list.

4. Optionally, select working hours for a bookable resource by performing the 
following steps:

a. Click the Working Hours tab. 

b. Click Add to add a schedule. Select a Start Day and Start Time, and an End 
Day and End time, for the resource to be available. Select a Type, either 
Regular or Extended.

c. In the Schedule drop down, you can select Alternating Weeks to create a 
schedule that alternates from one week to the next.

5. Optionally, set up access control for a bookable resource, to allow or prevent some 
users from seeing the resource, by performing the following steps:

a. Click the Access Control tab. By default, the Everyone group has Allowed 
access.

b. Click Add to add a user or group to the list. Search for and select one or more 
users and groups, and click the plus icon to add them to the list.

c. Use the drop down list to select Allowed or Denied to allow or deny access to 
the resource for that user or group.

6. Click Apply to apply your changes without closing the window, or click Save & 
Close to apply your changes and close the window.

Searching for Resources

To search for one or more resources:
1. In the Resources pane, enter the search string in the Search field. You can perform 

a search using one or more of the following attributes:

■ Name

■ ID

■ Capacity

■ Email

■ Type

■ Is External

■ Modified On

For more information, see Performing Simple Searches.

2. Click Search.

3. Click Clear to reset the Resources pane and repeat the search with a new string.

Alternatively, perform an advanced search by following the steps described in 
Performing Advanced Searches.



Managing Devices

Managing Enterprises 3-11

Managing Devices

Uploading Device Profiles

To upload a new device profile to Oracle Beehive:
1. From the Actions menu, select Upload Profile.

2. Click Browse.

3. Select a valid device profile in XML format and click Open.

4. Click Upload.

5. Click Close to exit the Upload File dialog box.

Viewing, Modifying, and Deleting Device Profiles

To modify a device profile:
1. From the Actions menu, select Open.

2. Click + next to any of the sections.

3. To modify a parameter, edit the value in the appropriate Value box.

4. Click Apply to apply your changes, or Reset to erase your changes.

To delete a device profile:
1. Select a profile.

2. From the Actions menu, select Delete.

Filtering Profiles
You can filter the list of device profiles displayed in the main window by entering filter 
criteria in the Filter by field and clicking the magnifying glass. You can filter profiles 
by name or by the Modified On date. Clicking X next to the Filter by field resets the 
filter criteria and reloads the profile window with no filter criteria.

Viewing Device Types for a Profile

To view all associated device types for a profile:
1. Select a profile.

2. From the View menu, select Types.

See Also: For more information about uploading device profiles, see 
"Uploading a Device Profile File" in Chapter 7, "Managing Oracle 
Beehive Mobility Services," in the Oracle Beehive Administrator's Guide.

Note: The device capabilities that appear when you click the 
Capabilities tab are read-only and cannot be modified.

Note: You can only delete profiles without associated device types.
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Listing Devices Types
Click the Types tab to list all available device types in the system and display 
associated information for each device type:

■ Name

■ Manufacturer

■ Model

■ Dev Inf DTD Version: Displays the Document Type Definition (DTD) version used 
to exchange information between the device and the Oracle Beehive server.

■ Software Version: Lists the device’s OS version.

■ Device Class: Lists the class of the device. Device classes include PDA, pager, and 
mobile.

■ OS: Lists the operating system that can run on the device.

■ Processor

Creating a Device Type

To create a device type:
1. Click New to bring up the New Device Type window.

2. Select a profile from the Device Profile pull-down menu.

3. Enter a manufacturer, model, device class, OS, and processor for the device type. If 
you specify a manufacturer and model, you do not need to provide the device 
class, OS, and processor. If you provide the device class, OS, and processor, you do 
not need to specify the manufacturer and model.

4. Optionally, enter the software version and DTD version for the device type. For 
more information, see Listing Devices Types.

5. Click Save & Close to create the device type and close the New Device Type 
window. Alternatively, click Apply to create the device type without closing the 
window.

Viewing and Modifying Device Types
To view a device type, select it in the main window. Details are displayed in a pane 
below the main window.

To modify a device type:
1. Click the Types tab.

2. Select a device type.

3. Modify any of the properties for the device type.

4. Click Apply to save your changes to the device type. Alternatively, click Reset to 
discard your changes.

Deleting Device Types
To delete a device type, select one or more device types and select Delete from the 
Actions menu. You will be prompted to confirm the deletion or deletions.
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Searching for Device Types
You can search the system for device types.

To search for device types:
1. In the Devices pane, click the Types tab. For more information, see Listing Devices 

Types.

2. Enter a search string in the Search field. For more information, see Performing 
Simple Searches.

3. Click Search.

4. Click Clear to reset the Devices pane and repeat the search with a new string.

Alternatively, perform an advanced search by following the steps described in 
Performing Advanced Searches.

Listing Devices

To list all devices registered in Oracle Beehive:
1. From the Manage Enterprises section in the left-hand pane, click Devices.

2. Click the Devices tab. To view details for a device, select it. Information for the 
selected device appears in the details pane.

Queuing Device Commands
You can queue different device commands to be performed at a later date.

To queue a command for a device:
1. From the Manage Enterprises section in the left-hand pane, click Devices.

2. Click the Devices tab.

3. Click the Commands tab.

4. Select the device.

5. From the Actions menu, select one of the following commands:

■ Check for Updates: Use this command to query the server for any application 
updates.

■ Upload Log: Use this command to upload device logs created by the installed 
applications to the server.

■ Upload Config: Use this command to upload an inventory of all installed 
applications and their respective configurations to the server.

■ Wipeout: Use this command to erase all applications and data from the 
selected device.

Deleting Device Commands
You can delete device commands from the queue at any time. You may want to delete 
device commands for one of the following reasons:

■ The device is not available.

■ The user is not currently accepting the queued command.
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■ You have queued another command with the Wipeout command pending and no 
longer want the command to be executed.

To delete a device command from the queue:
1. From the Manage Enterprises section in the left-hand pane, click Devices.

2. Click the Devices tab.

3. Click the Commands tab.

4. Select the device.

5. Select the queued command and click Delete.

Managing Policies
Policies establish rules for how the system should behave when certain events occur, 
based on evaluating the truth of a set of conditions, and then allowing or disallowing a 
resulting action.

Each policy is triggered by events.

A policy has one or more rules, each of which is triggered by one event.

Each rule contains one or more conditions, which are evaluated as true or false.

Each rule may activate an action, depending on the results of the evaluated conditions.

For more detailed information about policies, see the "Managing Oracle Beehive 
Events, and Policies" module of the Oracle Beehive Administrator’s Guide.

To access the main Policies view, click Policies in the Enterprise panel.

Listing Existing Policies
You can list the existing policies by clicking the Policies tab in the main Policies view. 
Each policy is listed by name, along with a description and an indication of whether 
the policy is currently enabled.

You can sort the list of policies by name.

You can restrict the view to one type of policy. From the Type drop down:

■ Select All to show all policies

■ Select General to show all non-record, non-audit policies

■ Select Record to show only record management policies

■ Select Audit to show only audit policies

Viewing Details of an Existing Policy
You can review the details of an existing policy. Click a policy from the list of existing 
policies. Details of the policy are shown in the lower pane.

The following information is shown on the General tab:

■ The Name of the policy

Note: If you do not have sufficient privileges, you cannot view audit 
policies.
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■ If a Template was used when creating this policy, that template’s name is shown

■ If the policy is currently enabled, the Enabled check box is checked

■ A Description of the policy

■ The date and actor associated with the policy creation, and the date and actor 
associated with the last modification of the policy

To view the rules included in the policy, click the Rules tab.

Click a rule to view information about that rule. The following information is shown:

■ On the General tab:

– The Name of the rule

– The rule’s Priority; rules are evaluated from lowest to highest integer value of 
priority

– The Event which triggers this rule

– The Action to be performed if the event occurs

– A Description of the rule

■ On the Conditions tab:

– One or more conditions may be shown. If there are conditions, the conditions 
must be met for the action shown on the General tab to be triggered 

■ On the Attributes tab:

– One or more attributes may be shown. Each attribute has a name and value 

■ On the Action Parameters tab:

– One or more Action Parameters may be listed. Each Action Parameter has a 
name and description

Creating a New Policy

To create a policy from a template:
1. From the main Policy view, click the New button

2. From the drop down, select Policy From Template

3. In the New Policy window, enter a name and description for the new policy. 

You must also select a template on which to base this policy; click a template from 
the list, and its name will be added to the Template field. 

Click Next to continue

4. Pick one or more rule templates and add them to the Rules column. Click Next to 
continue

5. Optionally, enter attribute values for each rule you added to the policy. You can 
use the search tool to pick from users, groups, or containers. Click Finish to create 
the policy.

To create a policy without using a template:
1. From the main Policy view, click the New button

2. From the drop down, select Policy 
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3. In the New Policy window, enter a name and description for the new policy. 

You can choose a Type: use Audit for audit policies, Record for records 
management policies, and General for all other types of policies.

Click Next to continue

4. Click the Rules tab

5. You must add one or more rules to a policy. Click the Add button to add a new 
rule. For each new rule, on the New Rule General tab:

■ Enter a Name and (optionally) a Description for the rule

■ Select a Priority for the rule. Rules will be evaluated in order of priority, from 
the lowest to the highest.

■ Select an Event which will trigger this rule, by clicking the search icon and 
picking an event from the list

■ Select an Action to be triggered when the Event occurs, by clicking the search 
icon and picking an action from the list

For each new rule, on the New Rule Conditions tab, you may optionally add one 
or more conditions to the rule:

a. Click Add to add a new condition

b. Select whether the condition on the left side of the function will be a Function 
or an Attribute from the first drop-down box

c. Enter a value on the left side of the equation, or click the list icon to select an 
attribute from a list

d. Select an operator from the center drop-down list

e. Select whether the condition on the right side of the function will be a 
Function or an Attribute from the second drop-down box

f. Enter a value on the right side of the equation, or click the list icon to select an 
attribute from a list

g. Click View to review the condition. While viewing, click Edit to edit the 
condition.

h. Click the AND or OR icons to create a compound condition

i. Click the Delete icon next to any condition row to delete that row. If there is 
only one condition row, click Remove to delete the entire condition

For each new rule, on the New Rule Action Parameters tab, you may optionally 
add one or more action parameters to the rule:

a. Click Add to add a new action parameter

b. Enter a name and a value for the new action parameter

6. Click Apply to save your policy but keep the window open for further changes, or 
click Save and Close to save your policy and close the New Policy window

Modifying a Policy

To modify a policy:
1. From the Policies pane, click a policy in the list
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2. On the General tab, you can change the name and description of the policy, and 
you can enable or disable the policy by clicking the Enabled check box

3. On the Rules tab, you can edit existing rules. Click the rule, and then make 
changes to it. Click the Add button to add a new rule. For each rule, on the Rule 
General tab:

■ Enter or modify the Name and Description for the rule

■ Select or modify the Priority for the rule. Rules will be evaluated in order of 
priority, from the lowest to the highest.

For each new or existing rule, on the Rule Conditions tab, you may add or modify 
conditions for the rule:

a. Click Add to add a new condition, or click Edit to edit the existing condition

b. Select whether the condition on the left side of the function will be a Function 
or an Attribute from the first drop-down box

c. Enter a value on the left side of the equation, or click the list icon to select an 
attribute from a list

d. Select an operator from the center drop-down list

e. Select whether the condition on the right side of the function will be a 
Function or an Attribute from the second drop-down box

f. Enter a value on the right side of the equation, or click the list icon to select an 
attribute from a list

g. Click View to review the condition. While viewing, click Edit to edit the 
condition.

h. Click the AND or OR icons to create a compound condition

i. Click the Delete icon next to any condition row to delete that row. If there is 
only one condition row, click Remove to delete the entire condition

For each new or existing rule, on the Rule Action Parameters tab, you may add or 
modify one or more action parameters to the rule:

a. Click Add to add a new action parameter, or click an existing action parameter 
to select it

b. Enter or modify a name and a value for each new or existing action parameter

4. Click Apply to save the changes you have made to the existing policy, or click 
Reset to revert to the previously saved version of the policy. Clicking Reset will 
remove any changes you have made so far to the policy

Note: You can edit an existing policy in the lower pane, or, if you 
prefer, select the policy and choose Open from the Action drop-down 
list to edit the policy in a separate window.
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Deleting Policies

To delete an existing policy:
1. From the Policies pane, click an existing policy

2. Click Delete or choose Delete from the Action drop-down list to delete the policy

3. On the confirmation dialog box, click OK to confirm deletion of the policy

Viewing Policy Templates
You can use policy templates when creating new policies to conveniently select from 
events related to a particular subject. To review the available policy templates, from 
the Policies pane, click the Templates tab. Each policy template is listed, along with a 
description.

Click a policy template to display information about that policy template. In the lower 
pane, the general and rule templates information is available.

With a policy template selected, you can click Policy From Template from the New 
drop down to create a new policy based on that template. Then, follow the steps 
described in "Creating a New Policy".

Creating New Policy Templates
You can create a new policy template, based on a policy schema. Oracle Beehive comes 
with two default schemas: the Audit schema and the Records Management schema.

1. From the Policies pane, click the Templates tab, and then select Template From 
Schema from the New drop down. Or, from the Policies pane, click the Schemas 
tab, select a schema, and then click Template From Schema.

2. In the New Template dialog box, enter a name and (optionally) a description for 
the new policy template. If you started from the Templates tab, also pick a schema 
on which to base this template. Click Next.

3. Select one or more Rule Definitions from which rule templates should be created, 
by moving them into the Rule Templates column. Click Next.

4. For each rule definition, you can edit the attribute template. You can set attributes 
to be editable or non-editable, mandatory or optional, and whether to prompt 
users for a value. You can enter a default value, create a list of one or more allowed 
values, and (for some attributes) indicate that the attribute can have more than one 
value. 

When you are finished editing attribute templates, click Finish to create the new 
policy template.

Caution: You should not delete the default policies, as they are 
required for various Oracle Beehive functions to work properly. The 
default policies include the Audit Records Management policy, the 
Validate Password policy, the User Provisioning policy, and the User 
Deprovisioning policy. If you need to disable any of these policies, you 
can edit the policy, and de-select the Enabled check box.



Managing Policies

Managing Enterprises 3-19

Viewing Policy Schemas
You can use policy schemas when creating new policy templates to make use of 
pre-defined rule and attribute definitions. To review the available policy schemas, 
from the Policies pane, click the Schemas tab. Each policy schema is listed, along with 
a description.

Click a policy schema to display information about that policy schema. In the lower 
pane, the general and rule definitions information is available.

With a policy schema selected, you can click Template From Schema from the New 
drop down to create a new policy template based on that schema. Then, follow the 
steps described in "Creating New Policy Templates".

Creating New Policy Schemas
To create a new policy schema, perform the following steps:

1. From the Policies pane, click the Schemas tab. Then, click New, and select 
Schema.

2. In the New Schema window, enter a Name and (optionally) a Description for the 
new schema. From the Type drop down, pick Audit to create a new audit schema, 
Record to create a new record management schema, or General for all other 
schema types.

By default, a new default policy template will be created from your new policy 
schema. Uncheck the box to disable this behavior.

3. Click the Rule Definitions tab to create one or more rule definitions for this 
schema. Click Add. Then, in the New Rule Definition section, enter information 
about your new rule. On the General tab, give the rule a Name and (optionally) a 
Description. Select an Event using the event picker, and then an Action for that 
event using the action picker. 

4. For each new rule, on the Rule Conditions tab, you may add conditions for the 
rule:

a. Click Add to add a new condition, or click Edit to edit an existing condition

b. Select whether the condition on the left side of the function will be a Function 
or an Attribute from the first drop-down box

c. Enter a value on the left side of the equation, or click the list icon to select an 
attribute from a list

d. Select an operator from the center drop-down list

e. Select whether the condition on the right side of the function will be a 
Function or an Attribute from the second drop-down box

f. Enter a value on the right side of the equation, or click the list icon to select an 
attribute from a list

g. Click View to review the condition. While viewing, click Edit to edit the 
condition.

h. Click the AND or OR icons to create a compound condition

i. Click the Delete icon next to any condition row to delete that row. If there is 
only one condition row, click Remove to delete the entire condition

5. For each rule, on the rule Attribute Definitions tab, you may add or modify one or 
more attribute definitions to the rule:
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a. Click Add to add a new attribute definition, or click an existing attribute 
definition to select it and then click Edit

b. In the Attribute Definition dialog box, pick an attribute type from the drop 
down, and enter a Name and (optionally) a Description for the attribute.

c. You can set one or more default values for the attribute in the Default Values 
section. To set more than one default value, you must select the Can have 
more than one value check box. (This check box is only visible for data types 
that support multiple values.)

d. For some data types, you can set a minimum value, maximum value, or both. 
Enter these in the Minimum Value and Maximum Value sections. 

e. For some data types, you can set one or more allowed values. Set these in the 
Allowed Values section. 

f. When you have finished setting the parameters of the new attribute definition, 
click OK. The new attribute definition is shown in the list on the Attribute 
Definitions tab.

6. For each rule, on the Rule Action Parameters tab, you may add or modify one or 
more action parameters to the rule:

a. Click Add to add a new action parameter, or click an existing action parameter 
to select it

b. Enter or modify a name and a value for each new or existing action parameter

7. When you are finished creating the new schema, click Apply to create it without 
closing the New Schema window, or click Save and Close to create the schema 
and close the window. Your new schema is listed on the Schemas tab of the 
Policies pane.

Viewing Action Definitions
Policies invoke actions based on events and conditions. When you create or edit a rule, 
you must use one of these actions to define what Oracle Beehive should do when the 
rule event, and all conditions, are met. You can review the list of default actions.

To view the default action definitions, from the Policies pane, click the Action 
Definitions tab. Each action definition is listed, along with a description.

Click an action definition to display information about that action definition. In the 
lower pane, the Name, Description, Type, and Action string are displayed.

Managing Roles
A role is tied to a role definition and can be used to assign a set of privileges to 
multiple users. Though Oracle Beehive comes with a predefined set of roles and role 
definitions, you can create your own roles and role definitions to suit the needs of your 
enterprise.

Creating Role Definitions
A role definition is an Oracle Beehive entity that comprises access types and privileges 
for a given scope (enterprise, organization, team workspace, or personal workspace).

To create a role definition:
1. From the Enterprises panel, click Roles.
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2. If the scope for the role definition is your entire enterprise, proceed to step 3. If the 
scope for the role definition is an organization, team workspace, or personal 
workspace within your enterprise, perform the following steps:

a. Click the Search icon next to the Scope field.

b. Click the View Organizations icon to view a list of organizations within your 
enterprise. Alternatively, click the View Workspaces icon to view a list of team 
workspaces and personal workspaces within your enterprise.

c. Select an item from the list and click Add.

3. Click the Definitions tab.

4. From the New menu, select Definitions.

5. In the Name field, enter a unique name for the role definition. In the Description 
field, enter a brief description for the role definition.

6. Select the always enabled check box to ensure that all roles referencing this role 
definition are enabled by default. If the always enabled check box is deselected, 
roles referencing this role definition are disabled by default, and must be enabled 
individually.

7. Using the options in the Access types section, select the operations that can be 
performed on Oracle Beehive entities in this role definition. You can grant access, 
deny access, or leave access undefined for each access type:

■ All sets every access type to Granted for the role definition.

■ Read allows the user to view or open an artifact.

■ Write allows the user to alter an artifact.

■ Delete allows the user to delete an artifact.

■ Execute allows the user to run executable artifacts, such as installers and 
applications.

■ Discover only allows the user to discover the existence of an artifact in 
searches, lists, and directories. It does not let the user view the contents of an 
artifact.

8. Click the Privileges tab.

9. Click Add.

10. Select a privilege from the list and click Add. Alternatively, hold down Ctrl to 
select multiple privileges, and click Add.

Tip: A scope is a section of the Oracle Beehive system such as an 
enterprise, organization, personal workspace, or team workspace. 
When you create a role definition, you define its scope, which 
determines the availability and access of the role definition. For 
example, a role definition created within the scope of a specific team 
workspace is only valid in that workspace.

Note: For more information, see About Entities, Actors, and 
Artifacts.
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11. Click Save & Close to create the role definition and close the New Definition 
window. Alternatively, click Apply to create the role definition without closing the 
window.

Conceptualizing Role Definitions
When you decide to create a role definition, determine the needs you want fulfilled 
through the role definition in relation to your user base:

1. Where in your enterprise is this role definition valid? A role definition can be 
valid in a team workspace, in a personal workspace, in an organization, or across 
your entire enterprise. The logical area of effect for this role definition constitutes 
its scope.

2. What services should be available for this role definition? The type and number 
of accessible services constitute the privileges for the role definition.

3. What operations can be performed on Oracle Beehive entities via this role 
definition? The selected operations constitute the available access types for the role 
definition.

Creating Roles

To create a role:
1. Click New.

2. Enter a unique name for the role.

3. Click the search icon to access a list of role definitions. Select a role definition from 
the list. The selected role definition now appears in the Definitions field.

4. Optionally, enter a role description in the Description field.

5. Optionally, you can grant users, groups, or resources automatic access to this role 
by performing the following steps:

a. Depending on the type of entity to be granted access to the role, click the 
Groups tab, the Users tab, or the Resources tab.

b. Click Add.

c. Enter the full name or part of the name of a user, group, or resource in the 
Search field and click the magnifying glass to obtain a list of results.

d. Select an item from the list and click Add. Alternatively, hold down Ctrl to 
select multiple items, and click Add.

6. Click Save & Close.

Tip: A privilege is the authority to perform a set of operations within 
the Oracle Beehive system. Some privileges apply only to specific 
services, while others apply to all services. For example, the Calendar 
User privilege allows the user to use the calendaring functionality in 
Oracle Beehive, while the Login privilege allows the user to sign in to 
Oracle Beehive.

Note: A role definition remains inactive until you associate it with a 
role.
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Modifying Roles

To modify a role:
1. Select the role.

2. Modify the role as described in steps 2 through 5 of Creating Roles.

3. Click Apply to save your changes.

Managing Categories
Categories are a hierarchical structure of designations that may be applied to entities, 
including all of the artifacts stored in a workspace. Categories always exist at the 
enterprise scope.

Managing Audit
Auditing is the act of capturing and evaluating historical records of system events to 
assess system performance, track user activities, and identify issues, among other 
goals. The results of effective auditing include timely and informed decisions and 
actions, especially when resolving security threats or preventing them from occurring. 
For more detailed information, see "Managing Auditing Policies" in the "Managing 
Oracle Beehive Events, and Policies" module of the Oracle Beehive Administrator’s Guide.

To access the main Audit view, click Audit in the Enterprises panel.

On the Audit pane, the three primary tabs are Repository, Trails, and Policies. The 
primary tabs are rendered depending on the role(s) granted to the user that is signed 
in. The Policies tab is rendered only if the signed in user has the ’Audit Administrator’ 
role. Similarly, the Repository and Trails tabs are shown only if the signed in user has 
the ’Auditor’ role. A user with both roles, or a user with full administrator privileges, 
will see all three tabs.

Listing Audit Policies
You can list available audit policies by clicking the Policies tab in the main Audit view. 
(If you cannot see the Policies tab, you do not have sufficient privileges to manage 
audit policies.)

To search for audit policies:
1. Click the Policies tab.

2. Enter a search string in the Search field. For more information, see Performing 
Simple Searches.

3. Click the Search button.

4. Click the Clear button to reset the pane and repeat the search with a new string.

Alternatively, perform an advanced search by following the steps described in 
Performing Advanced Searches.

Creating Audit Policies
Creating an audit policy is exactly the same as creating any other policy. From the 
Audit pane, click the Policies tab. Then, follow the instructions found in Creating a 
New Policy.
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Modifying Audit Policies
To modify any audit policy you have created, click the audit policy in the main Audit 
view. You can either edit the details of the policy in the lower pane, or from the Action 
menu, click Open to edit the audit policy in a new window. Follow the steps described 
in Modifying a Policy to modify the various audit policy details.

Deleting Audit Policies
You can delete any audit policy you have created by selecting the audit policy in the 
main Audit view and clicking Delete from the menu bar. To delete multiple audit 
policies at once, hold down Ctrl while making your selections. You will be prompted 
to confirm the deletion or deletions.

Searching the Audit Repository
The Audit Repository contains all audited events. Auditors can search the repository 
for specific records and create audit trails from the search results. For more 
information, see Creating Audit Trails.

To search the audit repository for records:
1. In the main Audit view, click the Repository tab.

2. Enter a search string in the Search field. For more information, see Performing 
Simple Searches. The following attributes are available for searching:

3. Click the Search button. Your search results appear in the main window.

Note: Once an audit policy has been created with one or more Rules, 
you cannot change the base template on which the policy was created. 
If you want to make a policy using a different base template, you must 
create a new audit policy.

Table 3–1 Audit Record Search Attributes

Search 
Attribute Match Type Description

Actor exact The identifier of the actor (user) that caused the audit event(s)

ActorName contains The name of the actor that caused the audited event(s)

Event contains The audit event name

DateRange between start 
and end 
dates

The date range in which the audited event(s) occurred

Scope exact The identifier of the audited entity's parent container. For 
example, the workspace in which a document is stored. If Scope 
is not specified, the search defaults to the Enterprise container

Audited 
Entity ID

exact The CollabId of the audited entity. You must enter the complete 
CollabId string

Client IP 
Address

contains The IP address of the client that triggered the audit event

Client Name contains The client application name that triggered the audit event

Client Type contains The client type that triggered the audit event
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4. Click the Clear button to reset the pane and repeat the search with a new string.

Alternatively, perform an advanced search by following the steps described in 
Performing Advanced Searches.

Listing Audit Records
When you click the Repository tab in the main Audit view, you will see a list of audit 
records. Clicking an audit record brings up information about the record in the Details 
pane. Because audit records cannot be modified, they appear as read-only in the 
display.

Listing Audit Trails
When you click the Trails tab in the main Audit view, you will see a list of audit trails. 
The attributes for each audit trail are listed in the appropriate column:

■ Name (name)

■ Description (description)

■ Record Count: Lists the number of records in the audit trail.

■ Modified On: Lists a date/time stamp indicating when the trail was last updated.

■ Index: An integer is assigned to each audit trail in order, for your convenience. 
(This column is not shown by default.) 

Creating Audit Trails
To create an audit trail:

1. From the Trails tab of the Audit pane, click New. The New Audit Trail window 
opens.

2. Enter a Name and, optionally, a Description for the new audit trail.

3. You can add one or more audit records. Click the Audit Records tab. Click Add. 
The Audit Record Picker opens:

a. Scroll down the list of audit records, or use the search function to find audit 
records.

b. Select one or more records and click Add to add them. The Audit Record 
Picker closes, and your chosen records are added to the Audit Records list.

4. Click Save & Close to create your audit trail.

Modifying Audit Trails
You can modify any audit trail you have created by selecting the audit trail in the main 
Audit view. The audit trail details are shown in the lower pane. Make your desired 
changes and click Apply to apply them to the existing audit trail. 

Alternatively, you can select an audit trail and click Open from the Actions menu, to 
edit the audit trail in a separate window. Then, follow the procedure in Creating Audit 
Trails.

Note: Each parenthetical value represents the equivalent search 
attribute for the associated audit trail attribute. For more information, 
see Searching for Audit Trails and Performing Simple Searches.
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Deleting Audit Trails
You can delete any audit trail you have created by selecting the audit trail in the main 
Audit view and clicking Delete from the menu bar. To delete multiple audit trails at 
once, hold down Ctrl while making your selections. You will be prompted to confirm 
the deletion or deletions.

Exporting Audit Trails
You can export an audit trail in XML format by selecting the audit trail in the main 
Audit view and clicking Export from the menu bar. You will be prompted to provide a 
file name and a directory path for the export.

Searching for Audit Trails
You can search the system for audit trails.

To search the system for audit trails:
1. In the main Audit view, click the Trails tab.

2. Enter a search string in the Search field. For more information, see Performing 
Simple Searches.

3. Click the Search button.

4. Click the Clear button to reset the pane and repeat the search with a new string.

Alternatively, perform an advanced search by following the steps described in 
Performing Advanced Searches.

Managing Remote Repositories
Oracle Beehive allows you to grant access to remote content repositories using Oracle 
Universal Content Repository (UCM). You can add and configure UCM repositories 
using Oracle Beekeeper.

To manage remote repositories, from the Enterprises menu, click Remote 
Repositories. 

Remote repositories are created at some level of scope within your enterprise. Click the 
Scope icon above the remote repositories menu, and select a level of scope to view 
remote repositories for that level of scope.

Creating and Modifying Remote Repositories
1. To create a new remote repository, from the Remote Repositories pane, make sure 

you are at the desired level of scope, and then click New. 

To modify an existing remote repository, select the remote repository from the list. 
You can modify the remote repository’s attributes in the lower pane, or, from the 
Action menu click Open to open it for editing in a new window.

2. From the General tab, enter a Name and, optionally, a Description for the remote 
repository. From the Type drop down, select Oracle UCM.

If you are creating a new remote repository, click Next. If you are modifying an 
existing remote repository, click the Attribute Templates tab.

3. The Attribute Templates shows the attributes used to connect to your remote 
repository. Make sure the attribute values are set to the correct parameters to 
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connect to your Oracle UCM instance. To modify an attribute, select its row in the 
table and click Edit:

a. The Cannot be changed, Mandatory, and Prompt users for a value selections 
are not applicable for remote repository attributes; do not make changes to 
these check boxes.

b. Set a value for the attribute in the Default Values section. Do not select the 
Can have more than one value check box. (This check box is only visible for 
data types that support multiple values.)

c. Do not make changes to the Minimum Value and Maximum Value sections, if 
shown.

d. Do not make changes to the Allowed Values section, if shown. 

e. When you have finished setting the value for the attribute, click OK. The new 
attribute value is shown in the Attribute Templates list.

4. If you are modifying the remote repository configuration in the lower pane, click 
Apply to apply your changes. If you are creating a new remote repository, or 
modifying an existing remote repository configuration in a separate window, click 
Apply to apply your changes without closing the window, or click Save & Close 
to apply your changes and close the window.

Deleting Remote Repositories
To delete a remote repository, from the Remote Repositories pane, make sure you are 
at the desired level of scope. Select the remote repository in the list, and click Delete.
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4 Managing Services

This module provides an overview of the different services that administrators can 
manage using Oracle Beekeeper.

Accessing Services
To access a service, click it in the Services pane on the bottom-left side of the window. 
To view the current configuration of the service, click the Configuration tab. To view 
metrics for a service, click the Metrics tab. To view logs for a service, click the Logs 
tab.

Modifying Services
When you modify a service, you save a change or a series of changes as a proposed 
configuration. To apply your changes, you must validate and activate your proposed 
configuration. For more information, see Proposed Configuration and Active 
Configuration.

To modify a service:
1. Select the service in the Services pane on the bottom-left side of the window.

2. Click the Configuration tab.

3. Click Edit.

A window opens showing all of the configurable parameters and their current 
values

4. Modify the values for any of the parameters.

5. Click Save & Close to store your proposed changes.

6. If you made changes to a parameter of the Authentication Service included in the 
following list, you must run beectl modify_local_configuration_files 
after saving your changes. Until you do so, the changes will not be active in the 
system.

Note: The main window for each service only displays the active 
configuration for the service. Therefore, when you modify a service, 
your changes will not appear in the main window until you validate 
and activate your proposed configuration.
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■ AuthStoreType

■ JssoSessionTimeout

■ LoginAttempts

■ LockoutTime

■ OssoConfigFile

■ SsoLogoutUrl

■ SsoType

■ UseJazn

■ UseSecureCookie

■ WnaEnabled

■ WnaKeytab

■ WnaPrincipal

■ WsSecurityExpiry

■ WsSecuritySamlEnabled

■ WsSecuritySigKeyAlias

■ WsSecuritySigKeyPwd

Enabling and Disabling Services and Service Instances
You can set a service or service instance to be disabled. A disabled service or service 
instance will not start when Oracle Beehive is started. To start such a service, you must 
first enable it, and then start the service (or restart Oracle Beehive).

Many services are essential to the normal operation of Oracle Beehive, and therefore 
should not be disabled. To avoid system errors or a service outage, you should only 
disable a service if advised to do so by Oracle documentation or an Oracle service 
representative.

To enable or disable a service or service instance:

1. Click the name a service in the Services list. From the service pane, you can select 
a service instance from the Go to drop down list at the top of the pane.

Or, from the Topology module, navigate to a service or service instance, select it in 
the list, and from the View menu, click Configuration.

2. In the service pane, click the Configuration tab.

3. Click Edit. A new window opens, showing the service configuration parameters.

4. In the new window, click the Advanced link to show the advanced options.

5. Select Enabled or Disabled from the Status drop down list.

6. Click Apply to apply the change to the proposed configuration and leave the 
window open, or click Save & Close to apply the change and close the window.

Caution: The beectl modify_local_configuration_files 
command may restart various affected components of Oracle Beehive.
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7. You must activate your proposed configuration to apply your change. SeeActive 
Configuration for details.

Comparing Service Configuration Versions
From any Service view, you can compare current and prior configurations and 
proposed configurations, to see which service properties may have been changed. To 
compare configurations:

1. Click on any service. To compare a service instance configuration, use the Go to 
drop down list to navigate to the service instance.

2. On the Configuration tab, click Compare. The Compare Configuration Versions 
window opens.

3. Using the drop down boxes, select a Baseline Version and an Other Version to 
compare to it. Click Compare. In the lower pane, any differences between the two 
configuration versions are shown.

4. When you are done reviewing the changes, close the Compare Configuration 
Versions window.

Services

This section describes the services you can manage through Oracle Beekeeper:

■ Access Control

■ Alarm

■ Audit

■ Authentication

■ BeeCentral

■ Beehive Conferencing

■ CalDAV

■ Client Management

■ Coexistence

■ Conference

■ Device Management

■ Discussions

■ Email

■ Event

■ Fax Message

■ FTP

■ Identity Provider

■ Instant Message (IM)

See Also: For descriptions of the service properties, please consult 
"Oracle Beehive Property Reference" in the Oracle Beehive 
Administrator's Reference Guide.
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■ Management

■ Mobile Data Sync (OMA)

■ Mobile Device Management (Mobile DM)

■ Mobile Instant Message (MIM)

■ Mobile Mail

■ Mobile Push

■ Notification Delivery

■ Platform

■ Policy

■ Presence

■ Records Management

■ Resource Directory

■ Remote Content

■ Search

■ SES Endpoint

■ SMPP Delivery

■ Subscription

■ Syndication

■ Team Collaboration

■ Time Management

■ Time Zone

■ Transcoding

■ User Directory

■ Voice Message

■ WebDAV

■ Wiki

■ Workspace

■ XMPP

■ Zimbra Connector

■ Zimbra User Interface (UI)

Access Control
The Access Control Service manages how users are permitted to access (view, use, and 
manipulate) entities in Oracle Beehive, such as files, workspaces, client services, and 
shared resources.

Alarm
The Alarm Service handles all time management-related alerts for the system, and 
enables users to configure and receive alerts such as reminders prior to meeting start 
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times. The Alarm Service is also responsible for signaling the activation of other 
services at pre-configured times.

Audit
The Audit Service is the service interface to the Oracle Beehive Audit Framework, 
which supports and manages all aspects of auditing for system and business events, 
and policies.

Authentication
The Authentication Services manage all aspects of user authentication for Oracle 
Beehive, including single sign-on (SSO), user repository authentication, authentication 
policies, and encryption.

BeeCentral
The BeeCentral Service manages Oracle Beehive Central; the Web page provided for 
Oracle Beehive users, primarily for downloading clients and updates.

Beehive Conferencing
The Beehive Conferencing Service provides connectivity for Oracle Beehive 
Conferencing online meetings. You can designate locations for the Windows and 
Apple Macintosh client software, if you do not want to use the default locations 
(accessible from the Oracle Beehive Central client download page).

CalDAV
The CalDAV Service manages all time management-related features and settings that 
the system leverages using the Calendaring Extensions to WebDAV (CalDAV) 
protocol, including:

■ Session cache settings, such as the maximum number of entries allowed in the 
authentication token table and the length of time (in seconds) an authentication 
token is valid

■ Directory cache settings, such as the maximum number of entries allowed in the 
directory cache and the length of time (in seconds) an entry is valid

■ Collection-related settings, such as whether or not browsing on collections is 
enabled and the default media type for collections if none is specified in client 
requests

Client Management
The Client Management Service allows you to manage client software settings related 
to client connections, notification thresholds, and debugging.

Using the Client Management Service, you can:

Caution: After making changes to certain security-related 
parameters, and applying your changes, you must also run the 
beectl modify_local_configuration_files command on the 
command-line. Until you do so, your changes will not be active. See 
"Modifying Services" for a complete list of affected parameters.
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■ Set session timeout values

■ Enable trace logs and debug mode

■ Set the node address on which to listen for incoming client requests

■ Set the maximum number of pending notifications the Client Management Service 
will hold for supported clients

■ Suspend the threshold for the client notifications queue

Coexistence
The Coexistence Service enables organizations to integrate Microsoft Exchange Server 
2003 with Oracle Beehive for maximum interoperability.

Conference
The Conference Artifact Service enables Web conferencing capabilities including 
video, voice, text, instant messaging, and desktop sharing.

Device Management
The Device Management Service enables you to manage supported client software 
such as Oracle Beehive Integration for Outlook, installed on end-user computers, and 
mobile devices.

Discussions
The Discussions Service enables organizations to host threaded, online discussion 
forums in which users can browse message boards, and post and respond to messages.

Using the Discussions Service, you can:

■ Set policy- and security-based filters including anti-spam capabilities

■ Use predefined roles (moderator, reader, contributor, editor)

■ Control permissions for users and groups

■ Allow programmatic access through Web Services

Email
The Email Service supports all aspects of e-mail creation, delivery, and management 
for Oracle Beehive. 

Event
The Events Service manages business events and related configuration settings, 
including:

■ Handling requests from the Subscription Service regarding subscriptions on 
business events

■ Setting the log level for business events processing

See Also: For extensive documentation about how to manage and 
configure e-mail using Oracle Beekeeper, see Chapter 8, "Managing 
Oracle Beehive E-mail," in the Oracle Beehive Administrator's Guide
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■ Specifying the number of times the system should retry failed actions that result 
from business events

Fax Message
The Fax Message Service enables forwarding of fax messages from the Cisco Call 
Manager to Oracle Beehive users, as e-mail attachments.

FTP
The FTP Service supports and manages all content management-related features and 
settings that the system leverages through FTP and FTP over TLS, including:

■ Support for FTP clients such as CuteFTP, WS_FTP, and SmartFTP

■ Whether or not the specified FTP server is enabled for Oracle Beehive

■ The port number at which the FTP Service will listen for requests

■ The maximum number of ports the FTP Service can use for passive listening

■ The buffer size between streams during content uploads

■ The length of time (in seconds) the service will allow a user session to remain 
inactive before timing out

Identity Provider
The Identity Provider Service provides certificate authority features for Oracle 
Beehive, enabling the system to manage digital certificates and other related security 
credentials.

Instant Message (IM)
The Instant Message Service provides core instant messaging features, including:

■ Message encryption

■ Rosters (buddy lists) based on Oracle Beehive address books and People lists

■ Presence support (provided by the Presence Service) with customizable status 
settings

■ Offline capabilities such as sending an instant message through e-mail

■ Server-side message transcripts

Management
The Management Service supports all aspects of system administration for Oracle 
Beehive.

Using the Management Service, you can:

■ Configure system and infrastructure on the fly (host names, ports, connections, 
memory, and so on) and management (start, stop, refresh, and restart)

■ Monitor performance and usage in real time

■ Trace parameter configuration (including the ability to attach probes to 
transactions)

■ Identify and examine errors in transactions
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■ Link trace errors to log records

■ Manage logs

■ Manage log files including rotation and disposition functions (parameter and 
qualifier definitions)

■ Manage your log file repository (size management, truncation schedules)

■ Integrate your Oracle Beehive system with Oracle Enterprise Manager Grid 
Control

■ Remote monitoring through integration with existing Oracle and third-party 
system management tools and standardized protocols

Mobile Data Sync (OMA)
The Mobile Data Sync Service provides for automatic synchronization of e-mail, 
calendar, task, and address book data on mobile devices.

Mobile Device Management (Mobile DM)
The Mobile Device Management Service manages the communications and 
configuration settings for the Mobile Device Management Server, which enables 
connections between the Device Management Service and supported device-resident 
Mobile Device Management clients.

Mobile Instant Message (MIM)
The Mobile Instant Message service manages delivery of instant messages to and from 
mobile devices.

Mobile Mail
The Mobile Mail Service provides a complete Push IMAP (P-IMAP) v0.6 
implementation for real-time delivery of e-mail to users' mobile devices. The service 
also manages the features and settings related to push mail, including:

■ The maximum number of concurrent users the Mobile Mail Service will allow

■ The maximum number of e-mail messages the Mobile Mail Service will allow in 
each user's mobile device inbox

■ The number of invalid login attempts the Mobile Mail Service will allow each 
mobile user to make before closing a connection

■ Whether or not connections to the specified IMAP server are enabled

Mobile Push
The Mobile Push Service is responsible for delivering notifications to Push clients 
running on end users' mobile devices. It is, in essence, an event dispatcher for those 
devices. For example, Mobile Push Service alerts can indicate changes in users' 
inboxes, calendars, task lists, and address books. Alerts can also prompt users to take 
action on corresponding device management events.

Additionally, the Mobile Push Service manages the following features and settings:

■ The Internet-accessible address, port number range, and type of listener for the 
Mobile Push Server
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– Supported types include HTTP, TCP, and the Oracle Beehive Transport 
Infrastructure (BTI)

■ The length of time (in minutes) of inactivity the service will allow before 
terminating an unauthenticated session

■ The maximum number of concurrent connections the Mobile Push Service will 
allow

■ The number of invalid login attempts the Mobile Push Service will allow before 
closing a connection

Notification Delivery
The Notification Delivery Service is responsible for the delivery of event notifications. 
Message delivery can be accomplished through e-mail, instant messages, and Simple 
Message Service (SMS). The service also allows users to schedule when such 
notifications should be delivered or temporarily block them altogether.

Platform
The Platform Service enables organizations to leverage the Oracle Beehive platform 
and its APIs, and support integration and coexistence with third-party components, 
Web services, and custom solutions.

Policy
The Policy Service enables organizations to centrally apply, manage, and store 
business logic for Oracle Beehive events. A policy is a set of server-side rules that 
defines what actions the system must take when one or more events occur. Policies can 
apply to any Oracle Beehive entity, including users, artifacts, services, and workspaces. 
The Policy Service leverages the Oracle Beehive Event Framework, and also provides 
the following key features:

■ Policy and policy schema extensibility

■ Inheritance model that supports enterprise-level policies with exceptions and 
extensions for specified groups, levels, and entities

■ Policy templates that enable you to define the extensible characteristics of policies 
and the business rules that they contain

Presence
The Presence Service supports and manages all aspects of user and resource presence 
for Oracle Beehive. Presence is the ability to detect and identify the status of a user or 
resource, and then display that status to other users and resources in one or more 
clients or applications.

Records Management
The Records Management Service supports all aspects of records management of 
documents and e-mail for Oracle Beehive through integration with Oracle Universal 
Records Management (URM). Oracle URM enables you to manage records and 
retention policies, disposition processes, and litigation holds or freezes in a central 
repository, or Universal Records Management (URM) server. You can then apply 
policies, dispositions, and holds to content stored in other systems, such as Oracle 
Beehive. Although the records associated with e-mail and documents are managed by 
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Oracle URM, the artifacts themselves are stored and maintained in the Oracle Beehive 
content repository.

Resource Directory
The Resource Directory Service provides a common definition for all Oracle Beehive 
resources and a centralized location to access and manage resource entries. The 
Resource Directory Service manages all aspects of the resources provided in Oracle 
Beehive directories, enabling users to view and schedule resources through supported 
time management features. This includes related settings such as the total number of 
resources returned in search results.

Remote Content
The Remote Content Service provides connectivity to remote repositories using Oracle 
Universal Content Repository (UCM).

Search
The Search Service supports and manages all aspects of user-initiated, text-based 
searches for Oracle Beehive.

SES Endpoint
The SES Endpoint Service provides connectivity to Oracle Secure Enterprise Search.

SMPP Delivery
The SMPP Delivery Service provides Short Message Peer-to-Peer (SMPP) connectivity 
to other Oracle Beehive services, particularly mobility services.

Subscription
The Subscription Service handles all aspects of subscription logic for Oracle Beehive 
subscriptions.

Syndication
The Syndication Service provides Really Simple Syndication (RSS) feed subscription 
capability to Oracle Beehive users.

Team Collaboration
The Team Collaboration Service provides much of the functionality for the Oracle 
Beehive Workspaces client.

Note: Oracle URM is a separate product not included with Oracle 
Beehive. For more information about using Records Management with 
Oracle Beehive, see "Managing Records Management" in Chapter 6, 
"Managing Oracle Beehive Workspaces" of the Oracle Beehive 
Administrator's Guide.
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Time Management
The Time Management Service provides the coordination services for the core aspects 
of Oracle Beehive calendars, scheduling, task management, and reminders. This 
includes support for multiple calendars and task lists in workspaces, automatic 
updates of group-based invitations and task assignments resulting from group 
definition changes.

Time Zone
The Time Zone Service supports and manages all aspects of synchronizing user 
schedules and calendar entries across global time zones. The Time Zone Service unifies 
the coordination of all time zone-related components and activities in Oracle Beehive.

Transcoding
The Transcoding Service supports and manages all the data and audio conversions for 
Oracle Beehive voice and Web conferences.

User Directory
The User Directory Service manages all aspects of user directory management for 
Oracle Beehive and supports a variety of implementations including local storage of 
users and groups as well as integrations with existing Oracle and third-party user 
directories.

Other key user directory management features provided by the User Directory Service 
include:

■ Support for National Language Support (NLS) user aliases

■ Customizable user attribute fields

■ Attribute mapping with existing user directories

■ User creation through pre-defined templates

■ Import capabilities of directory data based on Extensible Markup Language (XML) 
files

■ Bulk user management functions such as creating, modifying, and deleting users

The User Directory Service supports integration with the following user directory 
servers:

■ Oracle Internet Directory

■ IBM Tivoli

■ Microsoft Active Directory

■ Sun Java System Directory Server

Voice Message
The Voice Message Service supports all aspects of voicemail and fax management for 
Oracle Beehive. The Voice Message Service can be leveraged by the E-mail Service, 
enabling delivery of voicemail messages and faxes as e-mail. The Voice Message 
Service also supports multiple locations, including private branch exchanges (PBXs), 
and multiple languages, enabling enterprises to support a variety of network and user 
needs all within a single Oracle Beehive instance. Supported options include 
integration of existing telephony infrastructures with Oracle Beehive.
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WebDAV
The WebDAV Service supports and manages all content management-related features 
and settings that the system leverages over the Web-based Distributed Authoring and 
Versioning (WebDAV) protocol, including:

■ Support for WebDAV clients

■ Whether or not the specified WebDAV server is enabled for Oracle Beehive

■ The default authentication scheme for WebDAV clients

■ Length of time (in minutes) before browser-based and WebDAV-based client 
cookies expire

■ The minimum value (in minutes) allowed for content locks

■ Length of time (in minutes) before the system refreshes each active user's 
preferences

■ The buffer size between streams during content uploads and downloads

■ Shortcuts for content

Wiki
The Wiki Service provides the Oracle Beehive Wiki functionality in the Oracle Beehive 
Workspaces client.

Workspace
The Workspace Service supports all the features and functionality provided by Oracle 
Beehive personal and team workspaces. In addition to collaborating with other 
workspace members and managing their artifacts, the Workspace Service enables 
users to manage their own workspace environments. The Workspace Service provides 
XML-based templates that enable self-service workspace creation, including the 
configuration of workspace properties such as workspace name, description, and 
URLs, among others. The Workspace Service enables you to manage workspaces from 
the enterprise level by configuring settings such as soft and hard quotas for 
workspaces and groups.

XMPP
The XMPP Service supports and manages all the features and settings that the system 
exposes through the Extensible Messaging and Presence Protocol (XMPP) v 0.9 and 
1.0., including:

■ Support for XMPP clients such as Pidgin (formerly Gaim), iChat, and Trillion Pro

■ Multiple authentication methods

■ The list of all supported messaging agents

■ The port number at which all XMPP servers will communicate

■ The port number at which the system will encrypt messages over Secure Sockets 
Layer (SSL)

■ The default language for messages
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Zimbra Connector
The Zimbra Connector Service communicates between the Oracle Beehive server and 
any deployed instances of Oracle Beehive Integration for Zimbra.

Zimbra User Interface (UI)
The Zimbra User Interface Service provides some of the custom functionality available 
through Oracle Beehive Webmail.
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AMy Favorites

The My Favorites is a useful bookmark feature of Oracle Beekeeper. This chapter 
includes the following sections:

■ About My Favorites

■ Listing Favorites

■ Modifying a Favorite

■ Deleting a Favorite

About My Favorites
The My Favorites feature allows administrators to bookmark their favorite 
functionality or modules. For instance, artifact management or system management.

You can access this feature by using the My Favorites option on the left-side of the 
page.

Listing Favorites
To list your favorite bookmarks:

1. Click My Favorites on the left-side of the page.

2. From the shortcut menu, click Manage Favorites.

3. The list of favorites is displayed under the Favorites tab in the Preferences dialog 
box.

Modifying a Favorite
To modify an existing favorite:

1. Click My Favorites on the left-side of the page.

2. From the shortcut menu, click Manage Favorites.

3. Select a favorite from the list of favorites.

4. In the Preferences dialog box, click the Edit icon.

5. The Edit Favorite dialog box is displayed. You can only edit the Name field.

6. Click OK.

7. Click Apply to apply the changes.

8. Click Save & Close.
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Deleting a Favorite
To delete an existing favorite:

1. Click My Favorites on the left-side of the page.

2. From the shortcut menu, click Manage Favorites.

3. Select a favorite from the list of favorites.

4. In the Preferences dialog box, click the Delete icon.

5. In the confirmation dialog box, click OK to confirm the delete operation.
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audit policy

Created from one audit template and one audit scope.

audit record

The stored immutable data of an audited event. Audit records are verifiable; their 
integrity can be tested at any time to ensure that they are accurate and unchanged 
from the time of their creation.

audited event

Any auditable event that is actively being audited.

auditable event

Generated by any activity in the Oracle Beehive system that is capable of being 
audited. Sending an e-mail, changing the state of a document, and changing a service 
configuration are all examples of auditable events.

audit trail

A selection of audit records that are related based on a given context. For example, the 
audit trail of a lost business transaction consists of all the related audit records (stored 
events) that led up to the problem.

audit repository

A secure, immutable storage space for audit records.

audit scope

The logical area of effect of an audit policy, defined as a hierarchy of artifact containers 
(organizations, workspaces, and folders).

hard quota

The maximum disk space allowed for a workspace, organization, or enterprise. Once 
the hard quota is reached, no further create or update operations will be allowed until 
the quota violation is resolved.

soft quota

The disk space limit at which a warning event is created. Essentially, reaching your 
soft quota triggers a warning that you are approaching your hard quota
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